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Software Programming:  Model 4002 Status Monitor  for Windows 
 

 
 
Getting Started: 
 
 
I. INSTALLING SOFTWARE & HARDWARE REQUIREMENTS 
 
Insert disk 1 or CD-ROM and press Start, Run. Browse the floppy or CD-ROM for the setup.exe file or 
type x:\setup.exe and then press OK. 

P-75, 3 ½ Floppy, VGA Graphics Card, Printer, 32MB of RAM, 5MB of Hard Drive Space, 1 Serial 
Port, 1 Parallel Port, 101 Enhanced Keyboard, Mouse, CD-ROM and Windows 95, 98, NT 4.0 or 
2000. 

 

 
II. MAIN MENU 
 
The Main Menu gives the user five menu choices; File, Setup, Report, Polling and Help. 
 
a) The File Menu contains four sub-menus; History, Change Users, Printer Setup and Quit. 
 
b) The Setup Menu contains four sub-menus; Sites, Types, Users and Program. 
 
c) The Report Menu contains five sub-menus; Open History File, Sort History, View History, 

View Sites and View Types. 
 
d) The Polling Menu has four sub-menus; Single, Auto, Manual and Monitor. 
 
e) The Help Menu has three sub-menus; Contents, Keyword Search and About. 
 
III. ACCESSING THE HELP SCREENS 
 
Status Monitor  has a help screen to assist the user at any time during the program.  By pressing 
Help on the menu bar and selecting Keyword Search you can find the Help screen your looking for. 
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Begin Programming: 
 
IV. SETUP MENU 
 
From the menu bar select the Setup Menu.  Once the set up menu is displayed on the screen select the 
Program sub-menu. 
 
A. Program sub-menu: 
 
The Program Setup sub-menu will be displayed on the screen. 

     
1) Com Ports: you will need to select one of four Com Ports. Select the port that your 

Model 5493 or other RS-232 device is connected to your computer.  

2) Access Relay Delay: allows the user to set the time after an Access Relay is set or reset. 
 
3) Interrogation Delay Time: allows the user to set the time between the dialing of the 

phone number to the Setting of the Access Relay’s and the interrogating the remote unit 
(for PSTN applications). 

 
4) Start Date: allows you to choose the data at which the program will start polling 

(automatic mode only). This setting along with Start Time setting allows you to setup a 
poll days or even months in the future. 

 
5) Start Time: allows the user to choose the time at which the program will start polling 

(automatic mode only!).  This setting along with Polling Start Date setting allows the 
user to setup a polling sequence days or even months in the future. 

 
6) Exclude Period From/To: allows the user to set the start time of the exclude period.  

The Exclude Period To allows the user to set the end of the exclude period.  The 
Exclude Period keeps the Status Monitor  program from automatically polling during 
this time period.  If the user is sharing a communication path with another system or 
with one that downloads information once per day, as an example, Midnight.  You 
would set up the Exclude Period start time for Midnight and the Exclude Period end 
time to Midnight plus the download time. 

 
7) Site Interval: allows the user to choose the amount of time (in seconds) that the 

program will wait between polling sites.  The user will want a smaller number in this 
field if the system is a polled only system.  If the system is mixed with polled and self-
initiate, use a larger number to allow for self-initiated data to be acquired by the Status 
Monitor  program. 
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8) Poll Interval: allows the user to choose the amount of time (in minutes) that the 
program will wait between the polling cycles.  This time is the time that the program 
waits between polling the last site and begins the polling cycle again, starting with the 
first site.  NOTE:  If you are planning to select the option of “All” for Auto/Monitor 
Display, Save to History File, and Printer, we suggest that this interval be a large 
number to eliminate large data files, large printouts, and a full polling screen. 

 
9) Start Up: allows the user to choose whether the program will automatically start in the 

Normal, Monitor, or Auto mode when Status Monitor is executed. 
 

10) The Auto/Monitor Display: allows the user to choose whether all site data will be 
displayed, or just the changes that have occurred from the last time this site’s data was 
displayed. NOTE:  In the Single and Manual Modes all the data is displayed. 
 

11) Save To History: allows the user to select whether ALL polling information will be 
saved or just the CHANGES, or the save option should be turned off.  If you are 
keeping a record for trend analysis then select either ALL or Changes. 
 

12) Alarm Sound: allows the user to select whether the alarm sound will be active if an 
alarm is DISPLAYED ON THE SCREEN.  If the user has selected ALL on the 
Auto/Monitor Display option, the alarm will sound every time a site reports with an 
alarm.  However, if the user has selected CHANGES on the Auto/Monitor Display 
option, only alarms with changes will be heard.  Alarms for digital units (Model 2109 or 
5109) are chosen at the remote site via dipswitches or programming.  Alarms for analog 
units (Model 2110, 2222 and 5222) are set by the input, Value 0% and the input, Value 
100. Hitting <Esc> will reset this audible alarm 
 

13) Analog: allows the user to choose the percent change from the last logged analog value 
to get an alarm display. 
 

14) Print: allows the user to select whether ALL site data will be sent to the active printer, 
just the CHANGES, or if the print function should be shut off.  If the user wants to keep 
a record on paper as well as the computer then the user should select ALL or 
CHANGES. 
 
The Print option controllers the output of the ACSII output (Real time History printing). 
When printing with this option it is recommend using a dot matrix printer. 
 

15) Access Optimize: allows the user to choose whether the program will reset the access 
relays after test. Certain conditions must be met in order for the program to bypass 
resetting the access relays. First, the Access Reset must be turned on in the Sites dialog. 
Second, the following site must have the same Access code. 
 
The program also uses this setting to decide whether it will un-seize the PSTN line, or 
keeps the line seized for the next test. If the Dial # is the same as the next Dial #, the 
program will not issue the hang up command if this is “No” 
 
Note that the program makes decisions on Access and PSTN independently. That is, if 
the Dial # is the same but the Access is different, the program will reset the Access 
relays, but not the Line Seize Relay. 
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16) Must Receive Echo Back (For Model 5493 or Model 5106): Must Receive Echo 
Back allows the Status Monitor Software to verify that the Model 5493/5106 received 
the message correctly. Status Monitor Software will try four times before going on to 
the next function. 

 
B. Types 
 
The Types menu allows you to Add, Delete, Edit, or List the current types. 
A Type is defined as a device (Water Pump (ON/OFF), Door (OPEN/CLOSED), Flow 
(Analog)). 
 
ADD  -  The Add sub-menu allows the user to add types to the database. 

 
EDIT  -  The Edit sub-menu allows the user to change existing types in the database. 

 
 

1) Adding Types To Database 
 

When first installing the Status Monitor  software, select ADD.  The 
screen will display a window with he cursor flashing in the Type field.  
Enter a brief description in this field (Pmp 1, Beac 2, etc.) press “tab”, 
the cursor will move across to the Function field.  Enter in the Type 
description (Main Pump, Tower Beacon, etc.), press, “OK”.  NOTE:  
We suggest that the user compile a list of types and enter the entire list 
at one time. 

 
From the menu bar select the Setup Menu.  Once the set up menu is displayed on the screen 
select the Sites, Add sub-menu. 
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C. Sites: 
 
ADD  -  The Add sub-menu allows the user to add sites to the database. 

 
EDIT  -  The Edit sub-menu allows the user to change existing types in the database. 

 

1) Adding Sites to the Database 
 

Once the user has selected the ADD option a new window will appear on 
the screen with the cursor flashing in the first field, ADDRESS. 
 

2) Enter the Address of the remote site (this address is the address selected on the 
remote Signalcrafters module).  Press “tab”. 

 
3) The cursor will drop to the next selection, Description.  The Description field 

allows the user to enter the name of the site being added.  Once the Description 
has been entered press “tab”. 
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4) The cursor drops to the next selection, Auto Poll.  The Auto Poll option allows 
the user to define if this site being added should be part of an Auto Poll cycle.  
Move the cursor part of an Auto Poll cycle.  Use the drop down menu to select 
either “YES” or “NO” and press “tab”. 

 
5) The cursor then drops to the next selection, Dial Number.  The Dial Number 

input field allows the user to enter the phone number that the master station will 
dial to reach the remote site.  NOTE:  Leave this field blank if this site is not 
accessed via a PSTN.  To leave blank, or after phone number is entered, press, 
“tab”. 

 
6) The cursor will then drop to the next selection, Access.  The Access field allows 

the user to enter the access codes required to reach this site.  In autodial 
applications, the program will attempt to dial the phone number first, then set 
the access relays.  If you have multiple paths where relays are switched to make 
the correct connections an example is listed below: 

 
To set all the relays on a local 5109: 
Access code:   =   1001#A. 

Note: At the end of each relay access number you must type a period at the end 
of each relay code (1001#A.). 
 
To set the first four relays on a Model 5452 (8x1 Relay Module) from a Model 
5493 for a four-wire circuit the following access word is required: 

Access code   =   ABC1*1.ABC1*2.ABC1*3.ABC1*4. 

Note: At the end of each relay access number you must type a period at the end 
of each relay code (ABC1*1.). 

 
7) The cursor will then drop to the next selection, Response Time.  The Response 

Time field allows the user to choose the amount of time that this program will 
wait for a response from the remote.  In most cases, enter the Transmit Delay 
Time of the remote site module in the field.  Additional time may be required 
due to older units (slower DTMF ON/OFF times), excessive radio key up time, 
repeaters, satellite delays or PSTN delays.  This time is in seconds (10 sec 
recommend).  Once a time has been entered, press, “tab”. 

 
8) The cursor will then drop to the next selection, Sensor.  The Sensor field allows 

the user to select which type of site you are monitoring, Digital or Analog.  
Move the cursor to the correct Sensor and press the drop down menu. 

 
9) If you chose Analog, a new window will be seen on the screen with several 

options from which to choose.  There are two inputs into each 5222 Analog 
Module address, and the screen will display two inputs per address for you to fill 
in.  The second input will be added in the same fashion as the first. 
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a) The cursor will be located in the Units field.  The units’ field could be Vdc, 

mA, PSI or Vac. Select a Type in the Types scroll box. Press the type you 
want and the Units and Description field will fill in. 

 
b) Description field.  The description field could be Battery Voltage, RF 

Power, etc. 
 

c) The cursor will be at the Units Min field.  This field allows the user to set up 
the minimum acceptable analog value (in your units) that the Status 
Monitor  program will accept as normal.  If a value is reported below this 
value, it will be displayed in red on the screen, the computer speaker will 
sound (if selected \See Alarm Sound) and its corresponding relay will be set.  
This field is located under the 0%.  Once the value has been entered, press, 
“tab”. 

 
d) The cursor will move across to the next selection, Units Max.  This field 

allows the user to set up the maximum acceptable analog value (in your 
units) that the Status Monitor  program will accept as normal.  If a value is 
reported above this value, it will be displayed in red on the screen, the 
computer speaker will sound (if selected \See Alarm Sound) and its 
corresponding relay will be set.  This field is located under the 100%.  Once 
a value has been entered, press, “tab”. 

 
e) The cursor will then drop to the next selection, Transducer 0%.  The input 

Transducer 0% field allows the user to set up the transducer minimum value. 
 

Example:  If you are using a 0-2V transducer, this value would be 0.0.  If 
you are using a 4-20 mA transducer, this value would be 4.0.  Enter a value 
and press “tab”. 

 
f) The cursor will move to the next selection, Transducer 100%.  This field 

allows the user to set up the transducers maximum value. 
 

Example:  If you are using a 0-2V transducer, this value would be 2.0.  If 
you are using a 4-20 mA transducer, this value would be 20.0.  Enter a value 
and press “tab”. 
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g) The cursor will move to the next selection, Value 0%.  This field allows the 
user to set the translation minimum value. 

 
Example:  If you are monitoring a tank level from 0 to 20 feet your 
minimum would be 0.0 (feet).  If you are monitoring a battery voltage from 
0 to 12 V you minimum would be 0.0 (volts). 
 

h) The cursor will move to the next selection, Value 100%.  This field allows 
the user to set the translation maximum value. 

 
Example:  If you are monitoring a tank level from 0 to 20 feet the maximum 
value would be 20.0 (feet).  If you are monitoring a battery voltage from 0 to 
12V your maximum value would be 12 (volts).  Enter a value and select a 
new type for the second analog. 

 
10) If you selected the Digital option a window will now be displayed for the user to 

select the Type of input that the remote site is monitoring. First press the new 
button. Select a Type in the Types Available scroll box. Press the type you want 
with the mouse by pressing the mouse over the Type field. Press the Insert 
Type button to insert selection.  After a Type is selected press the mouse over 
the Norm combo box (Normal Relay setting). 

 
a) The cursor will now prompt you for information regarding the Norm 

field.  This option allows the user to choose whether the Digital input 
is “Normally Open”(OFF) or “Normally Closed (ON). This field is 
for your reference.  Select your option and press “tab”. 

 
c) The cursor will move to the next selection, Relay.  This option allows 

the user to choose a relay that will follow the remote input.  NOTE:  
It is recommended when assigning relay controls that the user 
employ a polled only system so that a self-initiating remote will not 
transmit over the relay control commands. 
 

d) Press the Save button to save the digital point.  
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D. Users sub-menu 
 
The last Option under the Setup menu is USERS.  The Users menu allows the user to 
select from four options. 
 
ADD  -  The Add sub-menu allows the user to add a new user to the system.  Once a User’s 
Name has been added, the Name/Password window will appear upon start up of Status 
Monitor . 

 

EDIT  -  The Edit sub-menu allows the user to change parameters of a user. 

 
 

1) Adding Users To the Database 
 

When initializing the system, choose the option ADD.  Once the ADD 
option has been selected a window will appear on the screen with the 
cursor in the Name field. 
 

2) The Name field should be filled in with a users name.  Enter the name 
and press “tab”.  NOTE:  A Manager Level user must be entered in as 
the first user (Manager \ Operator Privilege discussed below). 

 
3) The cursor will now prompt you to select the Privilege option.  There are 

two levels of security, Operator and Manager.  Managers can access all 
windows of the Status Monitor  software.  Operators cannot access the 
Setup sub menu.  NOTE:  Both the password and name must match 
with the user entered strings or the Operators privilege will be assumed.  
Select the Privilege and tab “enter”. 
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4) The cursor will now prompt the user for the Password.  The Password 
entry allows the user to associate a users name and password with a 
privilege. Once the password is entered press “enter”. 
 
NOTE: Retain your password for future use. Contact factory if you 
have lost your password. 

The Setup menu is now complete. 
 
 
V. FILE MENU: 
 
Move the cursor to the File Menu and press it.  There are four options to choose from 
the menu. 
 

1) The first step is to create a History File.  Select History, New.  Enter the 
name of the History File that you want the data stored. 
 
Example:  Jan94 History 
 
The File extension .HIS will automatically be added to the File name.  Once 
the file name has been entered press “OK” 
 
To change History files, from the Main Menu, select the File sub-menu, 
select History, Open. Select the file you want to use to store your history 
information. This option allows the user to select which History File the 
Data is collected in.  You may have many different History files to select 
from. 
 

2) Change User: The Change User allows different users to access the system 
without having to exit the Status Monitor  program 
 

3) Printer Setup: The Printer Setup allows you to select different printers or 
settings. Printer Setup control the output for the Report 
 

4) Exit: This option allows the user to exit the Status Monitor  program. 
 
 

VI. REPORT MENU: 
 
The Report option allows the user to browse through the reports.  
 
History Report: To view a history file Press the Report Menu then press Open 

History File, this will load the history file in memory. To sort the 
data, press Sort History, then press the desired sorting. To view the 
file in a report, press View History. The history file (*.his) is in a 
Comma Delimited File so it can be import in to Microsoft Access, 
Corel Paradox or any database program that the import of a Comma 
Delimited File. 
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Sites Report: To view all the sites press View Sites. This will display all sites that 
were entered. 

Types Report: To view all the types press View Types. This will display all types 
that were entered 

VII. POLLING MENU: 
 

The last menu selection is the Polling option.  The Polling Option opens a sub-
menu with four options; Single, Auto, Manual and Monitor. 
 
A) Single  -  The single option allows the user to poll just one selected site.  

After choosing the Single Mode, a site list will come on the screen.  Select 
the appropriate site and press, “enter”.  The Status Monitor  program will 
automatically dial (if set up for PSTN), access, poll and reset the access 
relays.  All data will be displayed on the screen in the Single Mode even if 
you have chosen the option of only CHANGES. 

 
B) Auto  -  The Auto mode allows the user to poll ALL sites that have been 

chosen for automatic polling.  The program automatically accesses, polls 
and resets the access parameters.  The Data will be displayed and printed 
according to the options that were discussed in the Program menu. 

 
C) Manual  -  The Manual poll mode allows the users to generate any 1-11 

character DTMF code.  Use this mode for (Re) Setting relays, Writing to / 
Reading from EE PROM registers, or for normal poll operations. 
NOTE: Check Application notes for some common commands. 

 
D) Monitor  -  This option allows the user to monitor all messages that the 

master station receives.  This mode is commonly used as a backup to another 
polling master station.  Therefore this mode will not control annunciation 
Relays. 
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Application Note: 

Signalcrafters Protocol: 

11 Data bytes (8 data bites, 1 start, 1 stop) and a ASCII return byte. 12 total bytes. 

Status: Model 2109 and 5109. 

1 2 3 4 5 6 7 8 9 10 11 
Module Address Status Alarm EOM 

Analog Module: Model 5222. 

1 2 3 4 5 6 7 8 9 10 11 
Module Address Analog 1 Analog 2 EOM 

 
Common Commands (Manual Poll): 
Module Address = 1001. 

Interrogate Remote: 1001# 
Set relay 1 of remote (Model 2452, 5452): 1001*1 
Reset relay 1 of remote (Model 2452, 5452): 1001#1 
Pickup phone with Model 5493: ABC1A1 
Tell remote to hang-up: 1001DDD 
Hang-up phone with Model 5493: ABC1#1 
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Model 5493  -  DTMF to ASCII Modem 

I. Setting up your Model 5493 for use with Status Monitor  software. 
 

A) Front Panel Dipswitch Settings: 
 

Dipswitch Function To Left To Right 
 1 Echo ASCII input  Echo after each DTMF out 
 2 Keyboard input Store and Forward 

3 Unused 
4 Radio/PSTN K1 for PTT K1 for Line Seize 

Program Wire Setup 
 
 

Pin BROWN 
Baud Rate 

RED 
Interdigit 

Timer 
(seconds) 

ORANGE 
K1 Key-Up 

Delay 
(seconds) 

YELLOW 
DTMF 

ON 
(ms) 

GREEN 
DTMF 
OFF 
(ms) 

BLUE 
Reset 
Timer 

(seconds) 

D 75 1.6  0.0 80 80 0.0 
1 150 0.1 0.1 05 05 0.5 
2 300 0.2 0.2 10 10 1.0 
3 600 0.3 0.3 15 15 1.5 
4 1200 0.4 0.4 20 20 2.0 
5 2400 0.5 0.5 25 25 2.5 
6 4800 0.6 0.6 30 30 3.0 
7 9600 0.7 0.7 35 35 3.5 
8 75 0.8 0.8 40 40 4.0 
9 150 0.9 0.9 45 45 4.5 
0 300 1.0 1.0 50 50 5.0 
* 600 1.1 1.1 55 55 5.5 
# 1200 1.2 1.2 60 60 6.0 
A 2400 1.3 1.3 65 65 6.5 
B 4800 1.4 1.4 70 70 7.0 
C 9600 1.5 1.5 75 75 7.5 

 
 
* Notes: 

1) Program the orange “program wire” on 5493 Module to desired key-up delay (Refer to 
5493 Manual). 

2) K1 is not operated if the orange wire is programmed to “D”. 
 
 
II. Voltage 
 

1) Prior to making DC connections, please refer to 5493 Manual and drawings. 
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Files to Backup or Transfer 

V1.00 thru V1.13 
You will need to backup the data (Location of files list below). These same files can transfer to 
a new computer or when you upgrade to a new version of Status Monitor (the old data files will 
get erased when you upgrade so you will need to backup these files). 
 
Note: When upgrading, it is best to uninstall Status Monitor from the computer using the 
Add/Remove in the Control panel. 
 
Upgrading from V1.13 to V1.2 
Upgrading from V1.13 to V1.2 you must follow the steps below.   

1. Save database files (The default directory for V1.13 is: C:\Program 
Files\Signalcrafters\Status Monitor) that are listed below. 

2. Uninstall Signalcrafters Status Monitor Software V1.00 thru V1.13. 
3. Install V1.2 
4. Copy database files to the default directory for V1.2: C:\Program 

Files\Signalcrafters\Status Monitor\Data. 
 
Upgrading from V1.2 thru V1.25 
If you use Analog points: You must re-enter Analog Data Field “Input” again (2nd field). This 
field assigns the analog input (1 or 2). 
 
Backup Data files locations 
For Version 1.00 thru 1.13 
The default directory is: C:\Program Files\Signalcrafters\Status Monitor 

For Version 1.2 and higher 
The default directory is: C:\Program Files\Signalcrafters\Status Monitor\Data 

Files to Backup:  

analog.db 
digital.db 
sites.db, sites.PX, sites.XG0, sites.XG1, sites.XG2, sites.YG0, sites.YG1, sites.YG2 
types.db, types.PX, types.XG0, types.XG1, types.YG0, types.YG1 
users.db 
 
You may want to also backup history files. 

Files to Backup: *.his 


